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introduction to the impression CCT 

What is Impression? 

The Impression Learning Content Framework (LCF) is a system for creating computer-based 
training. It consists of two primary pieces, a Content Creation Tool (CCT) and a Runtime 
Engine Development Kit (RTE DevKit). Together, these two items provide the tools needed 
to create rich interactive e-learning. 

How does it work? 

The Impression LCF system is designed to create individual units of instruction called 
lessons. A lesson consists of a specially formatted XML file and associated multimedia 
assets. The lesson XML file includes data describing the visual layout of each screen (or 
storyboard), the storyboard content (including directions to the student), the multimedia 
assets used by the lesson, storyboard interaction, control instructions, and sequencing data. 

The created lessons are presented to the student using a custom player called a Runtime 
Engine (RTE). The RTE loads the XML file, then sequences and displays the content to the 
student. In addition, the RTE loads multimedia assets on demand, tracks, and manages the 
student's interactions with the lesson, and (if desired) reports the student's progress back to 
a Learning Management System (LMS). 

Although lesson XML files can be created with any tool, even Microsoft Notepad, the 
Impression CCT was designed specifically for the development of lesson files. During 
production, the CCT stores lesson data in a centralized data store called a content database. 
The database also contains configuration information that is used to present a customized 
authoring environment to content developers that closely matches the intended playback 
system, helping to enforce standardization and minimize content-creator workload. 

The custom players used to present lessons are created using the Runtime Engine 
Developer’s Kit (RTE DevKit). This kit includes the Base Class Framework—nearly 40 
Macromedia Flash ActionScript 2.0 classes that provide functionality for working with the 



 

lesson XML files, including data processing, display management, and sequencing and 
control. Software developers use the Base Class Framework to develop a unique solution 
completely customized to meet project goals. 

Ultimately, the lesson XML file, associated multimedia assets, and custom RTE are packaged 
together as a single lesson, and are then ready for deployment and use. 

Production process  

There are typically four main steps in the courseware production process:  preproduction, 
production, packaging, and deployment. 

Impression LCF 

 

Preproduction 
Infrastructure decisions should be made during the preproduction phase of development, 
including runtime look and feel, deployment and LMS interface options, and production 
structure. Note that these decisions do not need to be “cast in stone,” but the more of them 
that are finalized, the smoother the production process will be. 

Tip:  The Impression New Project Manager’s Workbook is designed to support the 
preproduction process. 
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Production 
The production phase occurs when the courseware is actually developed. At this time, the 
instructional designers, subject matter experts, or other content creators use the Impression 
CCT to develop the individual units of instruction. In conjunction with lesson creation, media 
artists create the multimedia assets that will accompany each lesson. These assets are stored 
in a centralized location and are accessible to CCT users, who select and incorporate the 
assets into the instructional material. During content development, the project programmers 
use the RTE DevKit to develop the courseware runtime engine. 

User’s G
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Packaging 
When a lesson is ready for release, it is packaged. The details of the packaging process are 
usually unique to a project; but generally, packaging is the process of extracting the lesson 
XML from the content database and copying it, its associated multimedia assets, and the 
custom RTE to a single location for deployment. At the conclusion of the production process, 
courseware typically consists of a number of these packages. 

Packaging Process 
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Deployment 
Depending on the project's requirements, content may be deployed as a standalone CD-
ROM, within a Local Area Network (LAN), or available as a web-based application accessed 
through an LMS. Regardless of the final environment, the lessons, once packaged, are ready 
to be deployed. User’s G
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Deployment Options 
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Although the Content Creation Tool (CCT) provides a great deal of functionality, the majority 
of your time as a content creator is spent in a few key areas: the Groups window, Lesson 
Editor, and Guide Editor. Another key area, the Import/Export Wizard, packages content for 
distribution. This section identifies those areas, their purpose, and some of their major 
functions. 

Groups window 
The Groups window is the first display shown after the program has finished initialization 
and the splash screen has closed. This window displays a complete list of the content 
accessible from a database. The Groups window is the place to select a lesson or guide for 
editing. 

The Groups window includes functions for changing databases and database modes, editing 
lessons and groups, modifying Project Properties, and managing user rights. 

Groups window  

 



 

Lesson Editor 
The Lesson Editor is the single location for editing lessons. It contains tools for editing and 
arranging storyboards, the building blocks of lessons. You can also print reports, access the 
Import/Export Wizard, create and restore lesson milestones (snapshots of your lesson data), 
and (if supported) preview your lesson. 

Lesson Editor  

 

Guide Editor 
The Guide Editor is the single location for editing guides. Guides are optional lesson 
companion pieces for instructors to use in conjunction with the runtime.  

 Guide Editor 
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Import/Export Wizard 
The Import/Export Wizard exports lessons and imports previously exported lessons. Content 
must be exported from a content database for it to be available for later import or delivery.  

 Import/Export Wizard  
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Quick Tour 

This Quick Tour provides a basic run-through of the most common parts of the CCT.  

This document is divided into two sections, Administrative Tasks and User Tasks. As a 
content creator, the majority of your time will be spent completing user tasks.  The steps 
required to create, edit, and publish (or as we call it, package) content-completed lessons. 
However, in order to show you the CCT capabilities—without harming any existing data or 
requiring any additional setup steps—you must first perform the administrative tasks.  

Do not worry, unless you are responsible for managing your project's content database, the 
administrative tasks can be safely forgotten. If you are responsible for managing a content 
database, refer to the Impression Content Creation Tool Administrator's Guide and the 
Impression New Project Manager's Workbook for more information. 
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Administrative tasks 
This section details the steps necessary to create and prepare a content database for use.  
 
In this section, you will: 

• Create a content database 

• Set project-specific options 

• Create a course hierarchy 

Let’s get started 

1. Begin by running the Impression CCT. The program will start and, after the splash 
screen disappears, the Groups window will be displayed. If you have previously 
opened a content database, it reopens and the groups and lessons for that database 
will be shown. If you have not previously opened a content database, a message will 
be displayed. 

2. Ensure the CCT is set to work with Microsoft Office Access .MDB files by choosing 
the Change Database Mode command from the File menu of the Groups window. 
Use the drop-down list in the Choose Database Mode dialog to select Access MDB 
files, and then choose OK to close the dialog. 

3. Create a new content database by choosing New Database… from the File menu. A 
standard Windows “Save As” dialog will appear. Select a location and a filename 
(the actual values do not matter), and then click Save. The database will be created 
at the specified location. 

4. The CCT automatically opens the newly created database. Because there are no 
project-specific options set for the new database, a message will appear reminding 
you to select the options using the Project Properties dialog. There are nearly 150 
project-specific properties that can be set for a content database. To save time, we 
are going to “cheat” and load an existing set of options.  

5. To set configuration information, choose the Project Properties command from the 
Tools menu of the Groups window. The Project Properties dialog appears. 

6. Choose the Import Properties… command from the File menu. A standard 
Windows “Open” dialog will appear. Using the dialog, open the quicktour 
Project Properties.xml file located in the \SampleData folder found in the 
CCT folder. By default, the CCT is installed in C:\Program 
Files\Impression\CCT. A confirmation message will appear, indicating 
successful import. Choose OK to close the message, and then choose Save Changes 
to update the content database with the imported properties. Finally, choose Close 
to exit the Project Properties dialog and return to the Groups window. 
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7. Choose Lesson/Group Editor from the Tools menu of the Groups window. The Edit 
Groups window will appear. From the Lesson menu, choose Add New 
Lesson/Group…. The Add/Edit Group Window will appear. 

8. Change the title of the lesson to “Sample Lesson” by typing it in the title textbox 
provided, and ensure that the group is a lesson (supports storyboards) checkbox is 
checked. Choose OK to close the Add/Edit Groups window and return to the Edit 
Groups window. User’s G
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9. Choose Save to commit your changes to the database, then choose Close to exit the 
Edit Groups window and return to the Groups window. 

Congratulations! You have created a new sample database, set its Project Properties, and 
added a simple course hierarchy. Either continue this Quick Tour directly from the Groups 
window or get a fresh start by closing the application. 

User tasks 
This section introduces the CCT components that you, as a content developer, will use most 
often.  
 
In this section, you will: 

• Select a lesson for editing 

• Create and edit a new storyboard in a lesson 

• Preview the storyboard 

• Package a lesson for distribution 

Let’s get started 

1. Begin by running the Impression CCT. The program will start and, after the splash 
screen disappears, the Groups window will be displayed. If you have previously 
opened a content database, it reopens and the groups and lessons for that database 
will be shown. If you have not previously opened a content database, a message will 
be displayed. 

2. Select the lesson titled Sample Lesson by clicking on its node in the Groups 
window’s content selector. There are three options for opening the lesson:  a) 
double-click on the node, b) choose the open lesson button in the bottom-right 
corner of the Groups window (verify that the open read-only checkbox is cleared), 
or c) select Edit Lesson from the File menu. The Groups window will close and the 
Lesson Editor window will appear. 
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3. From the Storyboard menu of the Lesson Editor, choose New, and then Storyboard. 
A new storyboard will be created and then selected for editing. Ensure the General 
tab is active by selecting General Properties from the View menu. Change the 
storyboard type to canvas by selecting Canvas from the type: drop-down list. 

4. Change the title and student text by typing it in the boxes provided, and then switch 
to the Specific tab by clicking on it. 

5. Select a background graphic by clicking on the ellipsis button (…) inside the right 
edge of the Background element, located at the top of the screen under the General 
and Specific tabs. A selection dialog called the Media Asset Picker will appear. 
Choose a graphic from the list on the left, and then choose Select to select the 
graphic and close the dialog. The editor updates to reflect your selection. 

6. Add a shape element to the Canvas by selecting the shape icon (a collage of circles 
and rectangles) to the right of the add: label on the right-hand side of the Lesson 
Editor window. The main display will dim, indicating that the editor is ready for you 
to draw. Draw on the main display by dragging and then releasing the mouse. 

7. Change the type of the shape to a circle by clicking on the circle icon next to the 
shape: label in the appearance frame. Next, fine-tune the position of the element. 
Click on the name of the element in the list: box to change its position. Change the 
values in the layout panel, or click on one of the grab-handlers (the small squares 
around the edges of the element's bounding rectangle) to change the element’s size. 

8. Preview this storyboard by choosing Preview Storyboard from the Tools menu. 
When you are finished, close the preview window, and return to the lesson. Note 
that you are viewing your content in the specifically assigned runtime engine for 
this project. Runtime engine appearance varies on a per - project basis; your 
specific runtime will look different than the one included with this Quick Tour.  

9. Ensure the element is selected by clicking on its name in the elements list: box. 
Change the behavior associated with the element by choosing pop-up text from the 
action drop-down in the behavior frame. Enter some text into the pop-up and then 
choose Preview again to see the updated storyboard. To view the pop-up text, press 
and hold your mouse button while inside the circle. To restore the default student 
text, release the mouse button. 

10. Now that the lesson is complete, package it using the Import/Export Wizard. From 
the File menu of the Lesson Editor, choose Import/Export Wizard. The 
Import/Export Wizard will appear. Choose Package Lesson from the listbox, and 
then choose Next. 
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11. Based on your preference, either choose a custom location for the package by 
clearing the use project default setting checkbox and specifying a location for the 
package (by entering a folder name), or using the default value provided. When you 
are finished, choose Next. If you choose to use a custom location, you may be 
prompted to confirm folder creation or content overwriting. 

12. Choose Package. The wizard will create and copy files as needed. When complete, 
choose Close to exit the Import/Export Wizard and return to the Lesson Editor. User’s G
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Congratulations! You have successfully created and modified a lesson, previewed your 
changes, and packaged the lesson for distribution.  

Where do we go from here? 
Return to the Groups window by choosing Close Lesson Editor from the Lesson Editor File 
menu. 

• Close the CCT using the Exit command on the File menu or the Windows close 
button in the upper-right corner. 

• View your packaged lesson by running the MyShell.EXE application located in the 
packaged lesson folder that you specified in step 11, above. 

• Take the packaged lesson (from the folder you specified in step 10) and import it as 
a SCORM object into your LMS (following the instructions in chapter 11, importing, 
exporting, and packaging). 
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selecting a content database 

About Impression databases 

The Impression Content Creation Tool (CCT) stores its lesson content and configuration data 
in a centralized repository called a content database. Content databases should be created 
on a per-project basis because the customization options apply to all content stored within 
the database.  

Content database formats 
Impression uses content databases stored in Microsoft SQL Server or databases created as 
standalone, Microsoft Office Access-compatible .MDB files. In both cases, the structure of the 
database itself is identical. Unlike a Microsoft Access-format content database, SQL Server 
content databases are accessed indirectly through the SQL connector database, which 
also manages user access to the SQL Server content databases. 

Using SQL Server content databases 

An SQL Server content database is an Impression content database served by a machine 
running Microsoft SQL Server. As mentioned above, SQL Server content databases are 
retrieved indirectly through the SQL connector database, which also manages user access to 
the content databases. In order to use the SQL Server, you will need the connection 
information. This information includes the machine name, login ID, and password of the 
SQL Server account authorized to access the SQL connector database. 

SQL Server access rights 
The Impression CCT supports access rights when using SQL Server data storage. Access 
rights are defined on a per-user basis for each content database. 



 

The following access rights are defined: 

• Content Creators/Users edit content in databases where they have been assigned 
rights.  

• Administrators can perform all actions that users can perform, plus they can add, 
remove, and rearrange lessons and groups, change Project Properties, edit content 
connection information, add new users, and add and remove access rights 
(including administrative access) for users. 

• Superusers can act as administrators for all content databases defined on a server. 
They can also permanently remove users from the system and create and delete 
content database connection information.  

SQL Server Structure  

 

Opening an SQL Server content database 
Opening an SQL server content database is simple. Click on the drop-down menu and select 
the file from the drop-down list generated by the connector database based on your access 
rights. 
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Using Microsoft Access content databases 

Microsoft Access-format content databases are the central repository for data stored in .MDB 
format. Note that Microsoft Access is not required to create and use .MDB databases. There 
are no user-specific rights; anyone who can enter the system is an administrator with full 
access to the data.  

User’s G
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How to create a Microsoft Access database: 
From the File menu of the Groups window, select New Database. Specify a directory (folder) 
and filename for the content database, then choose Save. A new .MDB content database with 
the name you chose will be created at the location you specified. Once created, the CCT will 
automatically open the new database. 

Microsoft Access Database Structure 

 

How to open an existing Microsoft Access database: 
From the File menu of the Groups window, select Open Database. When the Open 
Impression Database dialog displays, select the desired content database and then choose 
Open. The CCT will validate and open the database. 
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selecting a lesson/guide for editing 

Overview of the Groups window 

The Groups window is the first window shown after the program has finished initialization 
and the splash screen has closed. This window displays a complete list of the content 
accessible from a database. The Groups window is the location for selecting a lesson or guide 
for editing. 

In addition to providing access to lesson and guide editing, the Groups window includes 
functions for switching between databases and database modes, editing lessons and groups, 
modifying Project Properties, and managing user rights. 

Content selection 
Content (both lessons and, if supported, guides) can be opened either for editing or read-only 
review. 

Editing 

Opening a lesson or guide for editing allows the user to add, change, and delete content and 
store the updated information in the database. Only one user may open a lesson or guide for 
editing at a time. 

Reading 

Both lessons and guides can be opened in a read-only mode. While opened for reading, all 
content can be reviewed, reports printed, and data exported. No changes are permitted. Any 
number of users may open a given lesson or guide in read-only mode. 

Tip: It is important to note that a read-only copy of a lesson or guide is just that—a 
read-only copy, or snapshot, of a lesson or guide. Changes made while the lesson is 
open are not reflected in the read-only copy. 



 

Locking 

The Content Creation Tool (CCT) issues locks when a user selects a lesson or guide for 
reading or editing. These locks are deleted when the item is closed. As noted above, there is 
no limit on the number of read locks that can be issued for a lesson or guide. Only one lesson 
write lock and one guide write lock can be issued for a given lesson. This ensures that 
multiple users do not overwrite each other’s data. For more information on content locking, 
refer to Appendix A. 

Using the content selector 
The content selector is Impression’s treeview, or hierarchical list. It displays an organized 
view of the content contained within the currently selected database. Located in the Groups 
window, it is where content is selected for editing. Note that only lessons are editable; groups 
are not, as they contain no content of their own. 

To select a lesson, double-click on it, select Edit Lesson from the File menu, or select a 
lesson, and then select open lesson. 

Content selector  

 

Groups window commands 
There are a number of commands related to editing, reading, and locking lessons available 
from the Groups window. The following items are available on the Group window's Tools 
menu for editing and managing CCT content databases. 

Preview Lesson  

This menu item is only available if previewing has been enabled for the content database. If 
available, it allows previewing of the selected lesson. Refer to Chapter 11 for additional 
information on previewing. 
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Lesson/Group Editor  

This menu item opens the Lesson/Group Editor, a tool for adding, deleting, renaming, and 
rearranging lessons and groups. Refer to Chapter 3 in the Impression Content Creation Tool 
Administrator’s Guide for additional information. 

Project Properties 

This item opens the Project Properties dialog, which allows administrators to customize the 
appearance of the CCT for a particular project. Refer to Chapter 4 in the Impression Content 
Creation Tool Administrator’s Guide for additional information. 
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Lock Manager 

This item opens the Lock Manager, which provides a detailed display of all locks currently in 
the content database. Refer to Appendix A for additional information. 

Connector Management 

The Connector Management menu item opens the Impression Connector Management Tool 
where database administrators and superusers can add, delete, and manage databases and 
users. Refer to Chapter 2 of the Impression Content Creation Tool Administrator’s Guide for 
additional information.  
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creating content with the lesson editor 

Storyboard editing 

Storyboards are the building blocks of lesson content created in the Impression Content 
Creation Tool (CCT). A storyboard is an individual screen of instructional material. 
Storyboards have data elements shared by most types (editable from the General tab) and 
those that are unique to a particular storyboard type (editable on the Specific tab). Each 
individual storyboard is placed in order on the storyboard map. Typically, the top-to-bottom 
display of storyboards represents the beginning-to-end flow of the lesson.  

This chapter will explain the basics of creating, editing, and managing your storyboards.  

Creating storyboards 
Creating a storyboard will add a new blank storyboard to your project.  

How to create a new storyboard: 

From the Storyboard menu of the Lesson Editor, choose New, and then select the desired 
storyboard type.  

Editing storyboards  

Use both the General and Specific tab to enter storyboard content. To edit generic storyboard 
data, use the General tab. To edit type-specific storyboard data, use the Specific tab. 
Additional information on storyboard editing is available from Chapter 6. 

Saving storyboards 

Choosing the Save command from the File menu stores the lesson data in the database. The 
CCT can, based on user preferences, automatically save content changes when you exit a 
lesson or switch between storyboards. You can change the autosave behavior from the 
Preferences dialog (available from the Tools menu of the Lesson Editor). 



 

Arranging storyboards 
Storyboards within a lesson must be arranged to reflect the particular organization needed 
for your project. The map located on the left-hand side of the Lesson Editor displays the 
order of the storyboards within the currently opened lesson. The flow of storyboards within 
the lesson normally follows the top-down order of the lesson map. This order can be changed 
at any time using the storyboard movement commands. 

Storyboard movement commands: 
Command Description 
Move Up This command swaps the position of the selected storyboard 

with its previous sibling. 

Move Down This command swaps the position of the selected storyboard 
with its next sibling. 

Indent This command makes the current storyboard a child of its 
previous sibling. 

Outdent This command makes the current storyboard the next sibling of 
its parent. 

Move to Next Map If a secondary map is supported, this command makes the 
current storyboard the first top-level storyboard in the next 
map. If storyboards already exist in the next map, the current 
storyboard becomes their first sibling. 

Move to Previous Map If a secondary map is supported, this command makes the 
current storyboard the last top-level sibling in the previous map.  

 

How to use the storyboard movement commands: 

From the Storyboard menu of the Lesson Editor, choose the desired movement command. 

Edit menu commands 
The Impression CCT provides text clipboard support to data entry elements such as text 
boxes. Supported edit commands include Cut, Copy, Paste, Select All, Undo, and Redo. 

Undo and redo 

The Lesson Editor supports multiple undo and redo actions. Any action performed in the 
Lesson Editor that changes data can be undone.  

If you change your mind about one of your recent edits, simply use the Undo command to 
reverse the edit. Your changes will be undone in the sequential order in which they were 
created. If you decide that you would rather keep the change, choose the Redo command. 
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The most recent undone change is reapplied. Undo and Redo are available from the Edit 
menu of the Lesson Editor.  

Save commands cannot be undone; however, the edits enacted prior to the Save command 
are undoable. If you resave the data restored by one or more undo commands, you may be 
able to restore the lesson to its original state. Created milestones are not undoable, but 
previously created milestones can be deleted in the milestones dialog.  
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Selecting media 
Many storyboard types support external media files that can be added using the Specific tab. 
Clicking on the ellipsis button to the right side of the file type will bring up the “Media Asset 
Picker” for that particular media asset. Note that “Media Asset Picker” is a generic term for 
the media selection tool; the actual title of the selection tool will vary based on the media 
element being selected. When the Media Asset Picker window appears, it will list all of the 
available files in the media folder that match the preferred file type for the element being 
edited. For example, if the current element is a Flash Object, a list of Flash .SWF files will 
appear in the Picker.  

Media file insertion 

Use the Media Asset Picker to assign still graphic, sound, and Flash Video files.  

As just mentioned, each media asset type has an associated selector. To select a file, click on 
the ellipsis (…) button. When the Media Asset Picker dialog appears, it will display a list of 
files of the preferred type. To change the list, select a different item from the type: 
combobox. Select a media file from the list by clicking on it. The file will be displayed in the 
preview pane. Click Select to choose the file and dismiss the dialog or Cancel to dismiss the 
dialog without selecting a file.  

Clicking ellipsis button (…) menus, like the one shown here, causes the Media Asset 
Picker to appear. 

 

Deleting and recovering deleted storyboards 
You can delete single and multiple storyboards using the Storyboard menu available in the 
Lesson Editor. If a storyboard has one or more children listed in the map, you can choose to 
delete the storyboard and all of its children, or only delete the storyboard itself without 
deleting the children. If the children are not deleted, they are “promoted,” or outdented to 
their parent's level.  
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How to delete a single storyboard: 

Select a storyboard without children in the map, and then choose Delete Storyboard from 
the Storyboard menu. If you checked the prompt when deleting a single storyboard box in 
the Lesson Editor Preferences dialog, a dialog will be displayed asking you to confirm 
deletion; otherwise, the storyboard will be deleted without confirmation.  

How to delete multiple storyboards: 

Select a storyboard with children in the map, and then choose Delete Storyboard from the 
Storyboard menu. A dialog will be displayed asking you if you wish to delete only the selected 
storyboard, or the selected storyboard and all of its children. Choose delete selected and child 
storyboards, then choose Delete. The storyboard and all of its children will be deleted. 

How to delete a single storyboard with child storyboards: 

Select the storyboard, and then choose Delete from the storyboard menu. Choose delete 
selected storyboard only in the dialog displayed; finally, choose Delete to perform the action. 
The storyboard will be deleted, and its children will be promoted to the deleted storyboard's 
level. 

The delete multiple storyboards dialog allows you to choose whether to delete all 
indented storyboards associated with your selection or the selected storyboard only. 

 

How to recover previously deleted storyboards: 

In addition to using the undo command to undelete storyboards, you can recover any 
storyboard previously deleted, including those deleted during earlier editing sessions.  

To recover previously deleted storyboards, choose the Recover Deleted Storyboards 
command from the Storyboard menu. The recover storyboards dialog is displayed. Select the 
storyboards that you want to recover from the list, and then choose Recover. Choose Close 
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when you are finished recovering storyboards to dismiss the dialog and return to the Lesson 
Editor. 

Recover storyboards selector  
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Deleting recovered storyboards 

If you decide not to keep the recovered storyboards, either choose the delete command to 
delete them again, or use the undo command to undo the recovery action. 

Milestones  
A milestone is a “snapshot” of a lesson and consists of all lesson and guide data (including 
deleted storyboards) associated with the currently open lesson. Milestones can be created in 
the Lesson Editor or the Guide Editor during any stage of the content creation process. You 
can create as many milestones per lesson as desired. 

Milestones are intended to provide you with an extra level of data protection in case an 
extensive change, such as a data import, does not meet your expectations.  

The milestone dialog is used for saving (creating) and restoring milestones.  
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How to create a milestone in the Lesson and Guide Editors: 

Select Lesson Milestones from the File menu. The Milestones dialog appears and a list of the 
milestones created throughout the course of the lesson is displayed (if no milestones have 
been previously created, the box will be empty). Choose Save. Enter a short description of the 
milestone in the Notes field, and then choose OK. The data will be saved to the database and 
a confirmation message will be displayed.  

Tip:  If no milestones have been previously created, the dialog box will be empty.  

Restoring a milestone  

When a milestone is restored, all previous lesson data is replaced with the data from the 
restored milestone. 

CAUTION:  Content replaced when a milestone is restored is not recoverable through 
the Recover Deleted Storyboards dialog, but it can be restored by enacting the 
restore command. 

How to restore a milestone in the Lesson and Guide Editors: 

Select Lesson Milestones from the File menu. The Milestones dialog appears and a list of 
milestones created for the lesson is displayed. Select a milestone and click Restore. The data 
is restored and a confirmation message will be displayed. 

Tip:  Note that although both lesson and guide data are saved along with a 
milestone, only the data appropriate to your currently opened editor (lesson or 
guide) will be restored.  
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editing basic storyboard data 

Introduction to storyboards 

Storyboards are the building blocks of the content created in the Impression Content 
Creation Tool and cover a wide range of functionality. They can be used to display text, 
graphics, animations, and test students. This chapter will introduce you to Impression’s 
storyboard types and provide detail on most of the data elements on both the General and 
Specific tabs. 

Storyboard types 
Note that the available types for any given content database are controlled through the 
selected project properties.  

The Impression Content Creation Tool supports the following storyboard 
types: 

Storyboard Type Description 
Canvas The Canvas storyboard type is a still graphic-based 

storyboard that can be assigned overlay elements and 
interactive actions. 

Container Container storyboards are used as an aggregation and 
navigation aid when developing courseware with a 
nonlinear learning pathway. 

Flash Object The Flash Object storyboard type displays an embedded 
Flash .SWF file that can be built for one- or two-way 
communication with the runtime engine. 

Flash Video The Flash Video storyboard type plays traditional and 
stepped .SWF Flash animations. 



 

Matching Text to Graphics The Matching Text to Graphics storyboard type is a 
matching question that can be formatted with directions, 
four text question/graphic answer pairs, and one graphic 
distractor. 

Matching Text to Text The Matching Text to Text storyboard type is the same as 
the Matching Text to Graphics type, but uses text for the 
answers and distractor. 

Menu The Menu storyboard type is used as an organization and 
navigation tool when developing courseware with nonlinear 
navigation. 

Multiple-Choice Graphics The Multiple-Choice Graphics storyboard type is a 
multiple-choice question that can be formatted with one 
correct graphic answer and up to three graphic distractors. 

Multiple-Choice Text The Multiple-Choice Text storyboard is the same as the 
Multiple-Choice Graphics type, but uses text for the answer 
and distractors. 

Placeholder Placeholder storyboards are common screens that do not 
change from lesson to lesson within a course, such as a 
copyright or disclaimer screen. 

Rich Text The Rich Text storyboard type displays a screen of 
formatted text. 

Summary The Summary storyboard type is an unformatted text 
screen typically used to reinforce and wrap-up lesson 
content. It is often used to present aggregate information, 
such as student scoring. 

Title The Title storyboard type is a screen with a fixed visual 
appearance that is used to introduce students to lesson 
content. 

 

Editing basic storyboard types 

You will use the General and Specific tabs to edit your storyboard content. Switch between 
the tabs to access all of the storyboard fields. 
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Editing General tab fields  
General tab fields, found within your created storyboard, are generic fields found on almost 
all storyboard types. These fields can provide identification data, instructions to students, 
notes on the production process, and control remediation and navigation. Any fields 
appearing on the General tab are available for use with your project. 

Tip: Fields listed as “optional” may or may not be visible based on your content 
database project settings. Your project’s specification may not include the uses 
described below; check with your project administrator for further guidance. 
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Field Name Description 
Title Title of the storyboard. This is often displayed onscreen. 

Identifier Optional. A human-readable alphanumeric code intended 
to uniquely identify the storyboard within the lesson or 
across the entire project. 

Objective ID Optional. An alphanumeric code that identifies the learning 
objective associated with a storyboard. It is useful for 
“Matching Learning Objective Storyboards” remediation, or 
for sending detailed scoring information to a Learning 
Management System (LMS). 

Student Text Text associated with the storyboard. 

Student Directions Optional. Directions associated with the storyboard, such as 
“Click Next to continue”. 

Alternate Directions Optional. Student instructions associated with the 
storyboard that are only displayed under project-defined 
circumstances. For example, Alternate Directions could be 
displayed when the student has completed all required 
actions in the storyboard. 

Narration Text Optional. Information provided to a human narrator or 
modified data for a text-to-speech system. 

Narration File Optional. The narration file is an audio file associated with 
the lesson. 

Back Button Enabled Identifies when the Back button should be enabled. Options 
are always or never. 
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Next Button Enabled Identifies when the Next button should be enabled. Options 
are always, never, or when complete. 

Complete When Identifies the criteria required for the storyboard to be 
considered complete. The values shown here depend on the 
storyboard type. 
 
Note that if there are no criteria are marked as a completion 
requirement, then there are no requirements for 
completion other than viewing the storyboard. 

Automatically Advance 
when Complete 

Instructs the runtime engine that it should automatically 
advance to the next storyboard when the storyboard is 
complete. 

Question Type Question storyboards only.  Identifies the type of question: 
either a scored test question or an unscored comprehension 
check. Select the question type using the combobox located 
on the General tab. 

Using the General tab to assign remediation 
Remediation can be assigned to each testing storyboard. There are four primary remediation 
types that can be assigned individually or combined with other types. For example, 
storyboard range can be combined with custom messages. Here, a student would select an 
incorrect response, receive the message, and be returned, or “remediated,” to a preset series 
of storyboards.  

Tip: Remediation options, including supporting combination types, are set in the 
General Storyboard options in Project Properties. 

How to enter remediation data: 
Use the remediation type: combobox to select the desired type of remediation. Enter the 
appropriate information in the fields that appear below the combobox, or depending on type, 
on the Specific tab. 

The following remediation types are available: 
Remediation Type Description 
Custom Messages Individually written messages for correct or incorrect 

responses. 
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Extended Custom Messages Messages for correct, partially correct, and incorrect 
student responses, and are only available for matching 
question types 

Per-Response Messages Individually written responses for both answers and 
distractors. These are entered in the Specific tab. 

Matching Learning 
Objective Storyboards 

Uses the learning objective values specified in the content 
storyboards and uses those to build a range of related 
storyboards for review. 

Storyboard Range Specifies a series of storyboards where students will be sent 
to review the material. Select the starting and ending points 
of the range using the to: and from: fields on the General 
tab. 

User’s G
uide 

Editing Specific tab fields 
In addition to the common fields supported by most storyboards on the General tab, each 
storyboard type includes a number of type-specific fields. As their name implies, these fields 
are unique to each storyboard type. If a particular field does not apply to other storyboard 
types (such as a question or distractor field), it is considered “type-specific.”  

In general, editing type-specific fields is rather straightforward; simply enter the appropriate 
information into each data entry element shown on the Specific tab. Data entry elements 
include standard Windows items, including single- and multiline text boxes, checkboxes, and 
radio buttons, as well as asset and storyboard selectors. Refer to Chapter 7 for additional 
information on editing Canvas storyboards and Chapter 8 for additional information on 
Flash Video storyboards. 
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editing canvas storyboards 

Editing Canvas storyboards 

This chapter will provide instruction on how to create and edit Canvas storyboards.  

The Canvas storyboard is a graphic storyboard that features a single still graphic called the 
background. Content creators can draw any number of items called elements on top of the 
background. Each element can have one of several actions associated with it, including 
storyboard jumps, pop-up text and graphics, sounds, and hyperlinks.  

Selecting a background graphic 
To select a background graphic, select the ellipsis button just to the right of the background: 
textbox and use the Media Asset Picker that appears to choose a graphic file. For additional 
information on using the Media Asset Picker, refer to the “Media File Insertion” procedure 
outlined in Chapter 5. 

Adding elements 
Elements can be added to the Canvas storyboard type. The three types of elements—shapes, 
text, and graphics—can be assigned a title. Each element has an associated style and can be 
assigned a single associated behavior. Additionally, the elements can be overlapped and have 
their z-order (the front-to-back "depth" of the element) changed. There are no restrictions as 
to the number or type of elements that can be added to a storyboard.  

How to add an element: 

If the element editor is not visible on the right-hand side of the Canvas type-specific editor, 
display it by clicking on the element editor >> link to the right of the background: graphic 
selector.  

Add an element to the Canvas by selecting one of the three icons to the right of the add: label 
on the right-hand side of the Lesson Editor window. Once you have selected your  shape, 
text, or graphic element, the main display will dim, indicating that the editor is ready for you 



 

to draw. Draw on the main display by holding down the left mouse button, dragging, and 
releasing the left mouse button.  

Once the mouse button is released, the Canvas will return to normal brightness and your 
element will be drawn within the bounds specified.  

Canvas element panels 

Element appearance and behavior 

There are three types of elements: shapes, text, and graphics. Each element's visual style can 
be changed using the tools found in the appearance panel. These tools change based on the 
display type of the element. A graphic element can have a graphic associated with it. Text can 
be assigned a custom font and color. Shape supports the three variants of square, circle, and 
line, all with defined color and width.  

Element display types can be switched at any time. Simply select the element from the 
element list and select the display type available from the appearance panel. 
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Changing element types and styles 
Element types can be changed by selecting the Display type drop-down menu in the 
appearance category. Element changes are undoable actions.  

Element style options, like size and color, can be changed using the layout and appearance 
panels.  

Using the layout panel, change the position of the elements on the Canvas. The depth icons 
position the elements on the canvas; their placement is reflected in the element list. Also, use 
the layout panel to define values for left, top, width, and height. Fill in the desired layout 
options. 
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If formatting a new element, establish the type and use the options above. For an existing 
element, simply select the element in the element list and use the layout and appearance 
menus to change the existing values. 

Element action types 
Elements can be assigned a number of interactive actions. Use the action: drop-down menu 
located on the behavior panel to assign an action to your elements.  

The following element actions are available: 
Action Description 
Jump to Storyboard Display a specific storyboard. 

Pop-up Text Display additional text. 

Pop-up Graphic Display an additional graphic. 

Play Sound Play a sound. 

Hyperlink Sends learners to locations outside of the lesson content, 
such as websites. 

Command Project-defined action type. 

Element placement 

Moving and resizing elements 
Moving and resizing can be done by clicking on and dragging the outline of the element. The 
element, or shape, must be selected so that the outline is showing. Dimensions of these 
shapes can be changed by clicking and holding on the handle of the shape’s outline while 
dragging the handle.  
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To move the shape, click on the name of the shape (attached to the element itself), hold, and 
drag. Change the type of shape by clicking on the square, circle, or line icon in the 
appearance panel. Holding down the shift key while resizing an outline or clicking on the 
outline handle causes the outline of the shape to expand or shrink at the same pace, resulting 
in either a perfect square or an equally round circle. If a line is selected and the shift key is 
held down, the line will snap to the nearest ninety degrees, resulting in a straight horizontal 
or vertical line.  

Changing element depth (z-order) 
Change depth by using the element depth icons, found in the Layout panel. The Bring to 
Front and Send to Back icons will rearrange the order of the elements in the element list and 
onscreen display. Bring to Front places the element in front of the others. Send to Back 
places the element at the bottom of the element list.  

Z-order icons 
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editing flash video storyboards 

Flash Video storyboards 

Flash Video storyboards allow content creators to build storyboards that feature traditional 
and stepped Flash animations. Traditional Flash Videos are Flash animations that play 
straight through from the beginning to end like a movie. Stepped Flash Videos are Flash files 
that, unlike traditional Flash animations, are broken into shorter increments called steps. 
Each individual step can have its own student text.  

Tip: If stepped animations are supported by your project, a stepped animation 
check box option will be available from the right-hand side of the ellipsis button. If 
there is no box, stepped animations are not supported. 

Regardless of type, use the video: selector to choose the desired .SWF file, available from the 
Specific tab. 

Using the playback controls 
A simple video controller is located to the right of the video selector. There are buttons for 
play, pause, and stop. These buttons allow you to preview the animations. Both traditional 
and stepped animation types use these controls, though their functionality is slightly 
different.  

The play button for traditional animations plays the animation straight through. The stop 
button for the traditional animation resets the animation to the beginning of the file.  

The play button for stepped animations plays the currently selected step only. To select 
another step, highlight it in the steps list box and select it. The stop button for the stepped 
animation resets the animation to the beginning of the current step. It does not return it to 
the beginning of the file as it does for the traditional animation. Select the desired step from 
the step list box. 



 

Traditional Flash Video options 

For traditional flash videos, the following options are available: 
Option Description 
Autoplay Specifies whether or not the animation automatically 

should begin to play when it is displayed, without user 
interaction. 

Loop Specifies whether or not the animation will loop 
continuously. 

Stepped Flash Video options 
To specify that an animation is stepped, select the stepped animation box. You can add and 
delete steps, assign student text, and store production notes using the Step Details panel. 

Editing stepped animations 

How to add and remove steps 

To add a step to a stepped Flash Video, select the Add New button to the right of the steps: 
list box. Enter the student text and production notes in the appropriate Step Details fields. To 
remove a step, highlight the step you wish to delete in the steps: list box, and then choose 
Delete.  

Stepped Flash Video details panel 
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Automatically calculating steps (autofill) 
You can choose to have the Flash Video editor automatically create steps for each frame of 
your stepped animation.  

To do this, select the autofill steps link to the right of the steps: list box. The autofill steps 
dialog appears with the frame count. Click Yes to have the Content Creation Tool autofill the 
animation steps.  
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A storyboard map is an ordering of storyboards within a lesson. Typically, the top-to-bottom 
display of storyboards represents the beginning-to-end flow of the lesson. Storyboards, once 
added to a lesson, can be freely reordered by using the movement commands on the 
Storyboard menu. To change how the storyboard is identified in the map, use the Lesson 
Editor View menu. The Storyboard By Title command displays the storyboards by their 
titles; Storyboard By Identifier displays the storyboards by their identifiers.  

Storyboard map 

 

Tip: Storyboards can also be reordered using the move buttons located just below 
the storyboard map list or by dragging and dropping the storyboard to the new 
location. 

Hierarchical maps 
The storyboard map can be used to arrange storyboards into a hierarchical parent-child or 
section-subsection layout. Your project may use the hierarchical structure to support section-
based “exploration” of your content, or it may ignore the hierarchical information, leaving 
you free to use the hierarchy as an organizational or outlining tool. 
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Hierarchical storyboard map  

 

Secondary maps 
Some projects may support a secondary map. This map offers an additional ordering of 
storyboards containing content that typically should be available within the lesson but not 
presented as part of the main “flow.” 

Tip: The Content Creation Tool only allows one storyboard to be in one map at a 
time. 

Uses for secondary maps include test bank data, remediation storyboards that contain 
aggregated information, or storyboards that contain additional information not required to 
complete the lesson.  

Tip: You will want to check your project's guidelines for standards and capabilities to 
determine how and when to use hierarchical or secondary maps within your lesson 
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The Content Creation Tool includes several reports that allow you to create hardcopy 
information on storyboard and lesson data. If supported by your project, the previewer 
displays lesson content exactly the way it will appear as a final product in a single step! 

Using the report wizard 
The Report Wizard is available from the Groups window or the Lesson Editor, from the File 
menu.  

Report Wizard  

 



 

How to display a report in the Groups window: 

From the Groups window, select a lesson and then select the Report Wizard option from the 
File menu. Preview a report by double clicking on it, or highlighting it and then clicking 
Preview. The report appears as a new window. When finished with the report, use the 
standard Windows close option to exit the report. 

How to display a report in the Lesson Editor: 

To view a “lesson-wide” report, select the Report Wizard item from the File menu. Select the 
all storyboards button, and then a report by double clicking it or by highlighting it and then 
clicking Preview. 

To view a report for a single storyboard in the Lesson Editor, select the storyboard in the 
storyboard map, and select Report Wizard from the File menu or select the Report Wizard 
icon from the toolbar. Select the current storyboard only option, and then preview the 
report by double clicking it or by highlighting it and then clicking Preview.  

The report appears in a new window. 

Report types 
There are several report types included with the CCT. They can display storyboard titles and 
provide information about text, media assets, and student text. 

The CCT includes the following reports: 
Report Name Description 
Media Report The Media Report provides a printout of the media assets 

associated with each storyboard. 

Onscreen Text Report The Onscreen Text Report is a subset of the Storyboard 
Detail Report and contains all fields for each storyboard 
that are typically shown to the student. 

Storyboard Detail Report The Storyboard Detail Report provides complete 
information on each storyboard. 

Storyboard List Report The Storyboard List Report provides a printout of the 
storyboard titles from a lesson in the order that they appear 
on the storyboard map.  
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Onscreen Text Report 
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Storyboard List Report  
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Storyboard Detail Report 

 

Media Report 

 

 

Previewing 

The Impression CCT supports previewing, a review of created content within the actual 
runtime engine that is used to deploy the content. 

When enabled, you can preview a lesson by choosing Preview Lesson from the Tools menu of 
the Groups window or the Lesson Editor; or you can preview the current storyboard by 
choosing Preview Storyboard from the Tools menu of the Lesson Editor. 
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Previewing a Canvas storyboard with a Runtime Hosting Utility-based Previewer. 
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importing, exporting, and packaging 

Importing, exporting, and packaging options 

The Content Creation Tool offers a robust set of options for transferring data into or out of a 
content database. 

Importing 

The importing process inserts previously exported Impression data into an existing lesson. 
Data from other programs, such as Microsoft Word, cannot be imported into Impression.  

Exporting 

The exporting process saves XML data on a lesson or storyboard basis. You can use the 
exported XML to transfer data to other users.  

Packaging 

The packaging process exports the lesson and guide data, verifies and copies media assets, 
and (optionally) creates a manifest for the selected lesson.  

Manual saves: dump XML and save to file 

Manual saves can be invoked from the File menu of the Lesson and Guide Editors. These 
actions will save all of the data currently in memory. The lesson or guide is saved to a 
specified location in its raw form. Unlike the export and packaging commands, manual saves 
do not optimize the XML or HTML data—note that, for example, deleted storyboards and 
unused fields are included in the save. 

Manual save types 

Lesson Editor Saves 

The Dump XML command is the manual save option for the Lesson Editor. Remember that 
all of the data, including deleted storyboards will be saved out. 



 

To dump XML from the Lesson Editor, choose either the Dump Lesson XML… or Dump 
Storyboard XML… commands from the File menu. A standard Windows “Save As” dialog 
will appear. Enter the desired filename and location, then choose Save. The lesson's (or 
storyboard's) XML data is saved and the dialog is closed.  

Guide Editor Saves 

The Guide Editor’s Save as File… and Load from File… commands are a simple import and 
export. Use these two options to replace or save the current guide HTML. Both commands 
are found in the Guide Editor's File menu and use the standard Windows “Open” or “Save 
As” dialogs. 

Import/Export Wizard 

The Import/Export Wizard imports, exports, and packages lesson data. The Import/Export 
Wizard is available from the File menu of the Groups window or the Lesson Editor XML. 

Import/Export Wizard Actions 

 

Exporting  
Exporting is the process of saving out an entire lesson or selected storyboards of a lesson as 
an XML file.  

How to export a lesson: 

• Open the Import/Export Wizard, and then choose Export from the action: list box. 
Click Next to continue.  

• Choose a filename for the exported file by either typing a valid filename directly into 
the export filename: text box or by using the ellipsis button and the following “Save 
As” dialog. Choose the export all storyboards option to output all of the storyboards 
associated with the lesson. Click Next to continue. 

56   ◦   impression cct user's guide  



 

• Select Export. The lesson data will be exported to the specified filename.  

How to export selected storyboards: 

• Open the Import/Export Wizard, and then choose Export from the action: list box. 
Click Next to continue.  

• Choose a filename for the exported file by either typing a valid filename directly into 
the export filename: text box or by using the ellipsis button and the following “Save 
As” dialog. Choose the export selected storyboards option to output only the 
storyboards you select. Choose the Select… button, mark selected storyboards for 
export on the ensuing dialog, and then click Select. When you are done, click Next to 
continue. 
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• Select Export. A lesson containing only the selected storyboards will be exported to 
the specified filename. 

Storyboard Selector 
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Packaging 
The packaging process exports the data for the lesson and guide, verifies and copies any 
media assets used by the lesson, copies any other files associated with a lesson (such as 
runtime files), creates a manifest, and places all of that data into a specified location.  

How to package a lesson: 

• Access the Import/Export Wizard. Select the Package option from the Action: list, 
then choose Next. Choose a location for the package. Use the default location by 
checking the use project default setting box or use the ellipsis button to select a 
custom package and fill in the necessary information to change the location of the 
root folder. Select Next.  

• Click Package. When the packaging process is complete, a status-complete 
confirmation appears. 

Tip: Packaging properties are set and modified in Project Properties available from 
the Groups window. If your options have not been set, consult your Project Manager 
for guidance. 

Importing 
The importing process brings previously exported Impression data into a lesson. This data 
can be imported from another lesson within the same or a different content database. Use 
import to create a variation of a previously created lesson without reentering its data, to 
synchronize lessons developed in different databases or locations, or to merge portions of 
existing lessons into a new one.  

How to import lesson data: 

• Open the Import/Export Wizard, and then select Import Lesson from the action: 
list. Choose the file to import either by typing directly into the import filename: 
textbox or by using the ellipsis button to display a standard Windows “Open” dialog. 
Create a milestone by clicking create lesson milestone before import checkbox. 
Select Next.  

• Choose either insert imported data or overwrite existing data.  

Insert Imported Data 

The Insert Imported Data option imports the previously exported data as new storyboards. 
This does not affect previously created storyboards. The storyboards are imported into a 
lesson in a Container marked “Imported” and labeled with the date. If a storyboard is 
selected when the data is imported, the container becomes a child to the storyboard at the 
root level. Otherwise, the container is inserted at the root level. You can use the storyboard 
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movement commands, explained in Chapter 5, to arrange the imported storyboards within 
the lesson. 

Overwrite Existing Data 

The Overwrite Existing Data option replaces all existing storyboards with the imported 
ones. This should be done with caution as all preexisting data will be lost and this selection 
should be viewed as “starting over.”  
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If you only want to import a subset of the lesson, use the Select… button to bring up the 
storyboard selection dialog. Choose the storyboards you wish to import by checking them, 
and then choose Select to return to the Import/Export Wizard. Click Next.  

If your project does not support storyboard identifiers, skip this step. Choose keep existing 
identifiers to keep the identifiers already assigned to the storyboards with the data that will 
be imported or create new identifiers to have the CCT generate new identifiers. Click Next. 

Review your selections. If you are satisfied, choose Import. The lesson will be imported. 
Select Close to exit the Import/Export Wizard.  

Import Options  
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A Lesson Guide is an HTML document intended to serve as the instructor’s companion to 
an individual lesson. Guides can be synchronized with a runtime engine. During an 
instructor-led class, the guide advances, progressing alongside the students’ lesson. The 
lesson guide is not typically used by the students.  

Guide editor 
The Lesson Guide Editor is a simple HTML editor. Since lesson guides are straight HTML, 
you can use the editor included in the Content Creation Tool or another HTML editor, such 
as Macromedia Dreamweaver or Microsoft FrontPage, to modify the code. If you do this, use 
the Load from File… and Save to File… commands to quickly transfer the guide data to and 
from the content database. 

Lesson Guide Editor 
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Adding storyboard links 
Storyboard links in the Guide Editor work similarly to Canvas hotspots. Clicking the 
storyboard links (hyperlinks) created in the Guide Editor using the add command will 
synchronize the CCT with the runtime, allowing the storyboards and lesson guides to move 
together. This allows the instructor to keep in sync with the students.  

To create a storyboard link, select the storyboard link creator icon. When the storyboard 
picker appears, choose the desired storyboard, press Select, and the link is created.  

Storyboard link creator 
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customizing your experience 
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The preference options for the Lesson Editor allow you to personalize the Content Creation 
Tool's behavior.  

Lesson editor preferences 
You can change Lesson editor behaviors using the Preferences dialog, available from the 
Tools menu. Make the desired changes and then select OK.  

Lesson editor preferences dialog 
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The following items can be customized using the Preferences dialog: 
Item Description 
Spellcheck settings Check the boxes next to the classes of words to ignore. 

Custom dictionary Define a custom dictionary for Impression to use during 
your content creation using the Browse… button and its 
following dialog. 

Prompt when deleting a 
single storyboard 

Check this box to have the CCT prompt you to confirm the 
deletion of a storyboard with no children. Note that the CCT 
will always prompt when you select a storyboard with 
children. 

Separate the Delete menu 
item on the Storyboards 
menu 

Check this box to isolate the Delete menu item from other 
menu items. You will find this helpful if you are accidentally 
deleting storyboards. 

Autosave Choose when (or if) the CCT will automatically save the 
lesson to the content database. The options include never, 
when closing or exiting, and when changing storyboards. 

Resetting default preferences 

Use the reset preferences button to reset the CCT to its default values. 
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lesson locking 
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uide Lesson locks are issued by the Content Creation Tool when a user edits or reads a lesson or 

guide and are normally deleted when the user exits the lesson or guide.  

There are four different types of locks: lesson write, lesson read, guide write, and 
guide read. Only one lesson write lock and one guide write lock can be issued for a given 
lesson. This ensures that multiple users do not overwrite each other’s data. There is no limit 
on the number of read locks that can be issued for a lesson or guide. Although the Groups 
menu provides basic lock information for a content database, group, or lesson, the Lock 
Manager can be used to examine detailed lock information. 

Tip: There will only be locks in the Lock Manager if there are lessons currently opened 
(either for editing or reading).   

The Lock Manager 

The Lock Manager is the central location for viewing database locks and lock details, 
regardless of status. Locks can also be released here. It is available from the Tools Menu in 
the Groups window. 



 

Lock Manager with “all locks” option displayed 

 

How to use the Lock Manager: 
From Tools, select Lock Manager. Select the desired lock type and click Refresh, Delete, or 
Close, depending on which option is needed. You can also select the blue lock manager link 
and then follow the same procedure. 

Invalid locks and lock recovery 

An individual can remove his/her own personal locks. Those with administrative rights can 
remove all locks using the Lock Manager. You can access the Lock Manager in the Tools 
menu in the Groups window.  

Under normal operation, the Impression CCT automatically issues and removes lesson locks 
when users enter and leave the lesson and guide editors. Abnormal program termination, 
loss of database connectivity, and deliberate removal of locks can result in lock problems, 
including potential data loss. 

Automatic lock repair 

When the Impression CCT first opens a content database, it will automatically attempt to 
repair the current user's invalid locks. Specifically, if there is no other instance of the CCT 
open, then read and write lesson/guide locks containing the current user's name, the current 
machine name, and the machine's current IP address are automatically removed from the 
database. 

Removing invalid locks 

The Lock Manager can be used to remove locks left in the content database by a sudden loss 
of connectivity. Users with administrator-level access rights can remove any lock listed in the 
database. Users without administrator-level privileges can only remove locks owned by them. 
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Tip: The Lock Manager applies certain rules to the lock data to determine if a given 
lock is valid. These rules are very simplistic (for example, a lock record without a 
lesson ID is an invalid lock) and do not and cannot cover locks left from connectivity 
loss. Manual intervention is required to determine if a given lock is valid or not. 

Lock Manager filters 

The Lock Manager can filter the items shown in its grid. User’s G
uide 

The Lock Manager supports the following filters:  
Filter Name Description 
My locks Locks currently open by the logged-in user. Under normal 

circumstances, there should not be any locks of this type 
listed in the Lock Manager. 

All locks All locks currently in the database. 

Invalid locks All locks that the Content Creation Tool has determined to 
be invalid. 

Current lesson All locks for the lesson or group currently selected in the 
Groups window. If a group is selected, locks shown here will 
be for the group and all children of that group.  

Lock error messages and error handling 

If a lock is removed while the user is editing a lesson or guide, the CCT will attempt to 
reacquire the lock. The CCT will display one of the following messages depending on the 
success or failure of this operation. 

Lesson lock messages  
For lessons, the following messages can be issued: 

• The write lock originally issued to you for this lesson has been removed from the 
database. Since no changes have been recorded, a new write lock has been issued 
and your changes will be saved. 

• The write lock originally issued to you for this lesson has been removed from the 
database. Although no new changes were made to the database, a new lock could 
not be acquired and your changes will not be saved. You may wish to use the 'Dump 
Lesson XML' command to save your existing data. Contact your administrator for 
further guidance. 
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• The write lock originally issued to you for this lesson has been removed from the 
database. Changes have been made to the lesson since the last time you accessed the 
database. The most recent changes were made by [user] on [date]. Your changes 
will not be saved. You may wish to use the 'Dump Lesson XML' command to save 
your existing data. Contact this user and your administrator for further guidance. 

• The write lock issued to you for this lesson has been removed from the database. A 
new lesson write lock has been issued to [user]. Your changes will not be saved. You 
may wish to use the 'Dump Lesson XML' command to save your existing data. 
Contact this user and your administrator for further guidance. 

Guide lock messages  
For guides, the following messages can be issued: 

• The write lock issued to you for this guide has been removed from the database. A 
new guide write lock has been issued to [user]. Your changes will not be saved. You 
may wish to use the 'Save as File' command to save your existing data. Contact this 
user and your administrator for further guidance. 

• The write lock originally issued to you for this guide has been removed from the 
database. Changes have been made to the guide since the last time you accessed the 
database. The most recent changes were made by [user] on [date]. Your changes 
will not be saved. You may wish to use the 'Save as File' command to save your 
existing data. Contact this user and your administrator for further guidance. 

If a write lock is lost, and the CCT detects that the last changes before losing the lock were 
made by the current user, the following message is issued: 

• The write lock originally issued to you for this guide has been removed from the 
database. The guide was last saved by you on [date], and no one else is currently 
editing this guide. Do you want to try and reacquire a write lock? 

If the user chooses yes, the CCT attempts to reacquire the lock, and one of the following 
messages is displayed: 

• Write lock reacquired successfully. 

—Or— 

• A new lock could not be acquired and your changes will not be saved. You may wish 
to use the 'Save as File' command to save your existing data. Contact your 
administrator for further guidance. 

If the user chooses no, the following message is displayed: 

68   ◦   impression cct user's guide  



 

• Without a write lock, your changes will not be saved. Contact your administrator for 
further guidance. 
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database validation 

Impression database validation 

When the Impression CCT opens a database connection, regardless of mode, a number of 
checks are performed to ensure that the database is valid, and in the case of SQL Server 
databases, that the user accessing the database has sufficient rights to access the database. If 
the CCT detects a problem, the opening process is cancelled, and a message is displayed on 
the Groups window. 

Tip: Should an unexpected error occur at any time during the validation process, 
validation stops and the following message is displayed: Impression encountered an 
unexpected error while attempting to validate [database name]. 

Microsoft Access .MDB database checks 
For a Microsoft Access .MDB file, the following checks are performed: 

File existence 

If the specified file  does not exist, or no file is specified, one of the following messages is 
displayed: 

• You must select a valid Impression database before using the program. 

—Or— 

• [database name] was not found. Select a valid Impression database before using the 
program. 

File is read-only 

If the file exists, but is marked read-only, the following message is displayed: 



 

• Impression was unable to obtain a shared read/write lock on [database name]. 
Check to ensure that the file is not marked read-only and that it is not stored in a 
directory with read-only permissions 

Valid data connection 

If a data connection to the file cannot be opened, the following message is displayed: 

• Impression was unable to open a database connection to [database name]. This file 
may not be a valid Access-format database, or it may be corrupt. You may wish to 
validate the integrity of the file by opening it in Microsoft Access. 

Writeable data structure 

The CCT ensures that data fields can be edited by writing temporary data to the database, 
then removing that data. If an error occurs, the following message is displayed: 

• Impression was unable to update one or more of the database tables. Check to 
ensure that no other processes have the database open exclusively and try again.  

SQL connector database checks 
When opening an SQL data source, the Impression connector database is validated first. 
Once the Connector passes validation, the specific content database is validated. Connector 
database validation does not include checking for writable data tables. If the account 
associated with the connector database does not have write permissions, the CCT itself will 
function normally, but users with administrator or superuser rights will not be able to use the 
ICMT to add or remove users or content databases from the Connector. 

For the connector database, the following checks are performed: 

Valid data connection string 

If the data connection string (built from the Change SQL Connector dialog settings) is 
invalid, the following message is displayed: 

• There is no data source or catalog defined for the connector. Please enter 
connection information and try again. Check with your administrator for details. 

Valid data connection  

Using the validated connection string, the CCT attempts to open a connection. If an error 
occurs, the following message is displayed: 

• Impression was unable to open a database connection to the common connector. 
Check with your administrator to ensure that the machine and catalog are available 
and online, and that the account associated with the catalog has sufficient access 
rights. 
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Valid data structure 

The CCT validates the data structure by running a series of SQL queries on the Impression-
Specific tables in the database. If an error occurs, the following message is displayed: 

• Impression was unable to locate all of the required database tables and fields. 
Contact your administrator for further information. 

Connector record validation User’s G
uide 

The CCT checks to see if a record for the current user exists in the Connector database. If a 
record does not exist, one of the following messages is displayed: 

If there are no user records in the database: 

• The SQL connector database has no user records. If you are the administrator, use 
the Impression Connector Management Tool to initialize the database. If you are 
not the administrator, have the administrator perform this function. 

If there are user records, but none for the current user: 

• You do not have access rights to any database listed in the SQL connector. Contact 
your administrator for more information.  

SQL Server content database checks 
For the SQL Server-based content database, the following checks are performed: 

Valid data connection 

Using a connection string built from data in the Connector database, the CCT attempts to 
open a connection. If an error occurs, the following message is displayed: 

• Impression was unable to open a database connection to [database name]. Check 
with your administrator to ensure that the machine and catalog are available and 
online, and that the account associated with the catalog has sufficient access rights. 

Valid data structure 

The CCT validates the data structure by running a series of SQL queries on the Impression-
Specific tables in the database. If an error occurs, the following message is displayed: 

• Impression was unable to locate all of the required database tables and fields. 
Contact your administrator for further information. 

Writeable data structure 

The CCT ensures that data fields can be edited by writing temporary data to the database, 
then removing that data. If an error occurs, the following message is displayed: 
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• Impression was unable to update one or more of the database tables. Check to 
ensure that no other processes have the database open exclusively and try again.  
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database security 

Layered security 

Layered security is the best way to protect your projects and databases. Security should be 
handled on a system-wide and user-wide level. Limiting user access to SQL Server machines 
and Connector user login information increases security. It only takes one ill-intentioned 
person with access to the SQL Server to corrupt the database. Limiting system-wide database 
use to LAN connections is another effective way to reduce the risk of breaches. Internet 
servers increase security risks and are not recommended for use with Impression.  

SQL Server security procedures 

As part of your SQL Server security procedures, implement maintenance and backup plans 
based on the criteria set by your organization. Implementing a maintenance and backup plan 
safeguards against data loss and optimizes database performance. Maintenance plans serve 
two purposes: data backup and providing statistical updates on data. Data replication allows 
for disaster recovery. 

Microsoft Access security procedures 

Access databases should be backed up frequently. Methods like backing up files with tapes 
and CDs can safeguard against data loss. Storing backups at a separate location provides 
added security against “natural disasters.” 
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